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SPRACHE IN Paragraph-Style “05 - STANDARD Fließtext” passend einstellen

1	 Bienvenue dans GUITAR RIG MOBILE !
GUITAR RIG MOBILE est une solution d’enregistrement professionnelle pour les guitares et 
les basses. Elle comprend l’interface audio ultra compacte GUITAR RIG MOBILE I/O ainsi 
que la version ESSENTIAL du logiciel GUITAR RIG 4 encensé par la critique.

Le GUITAR RIG MOBILE I/O est une interface audio de qualité studio qui se connecte à votre 
ordinateur via USB 2.0. Cette interface embarque une entrée haute impédance pour les gui-
tares et basses électriques ainsi qu’une sortie stéréo pour la connecter à un système hifi, une 
console de mixage, une paire d’enceintes actives ou un casque. L’interface audio GUITAR RIG 
MOBILE I/O est conçue pour être utilisée avec le logiciel GUITAR RIG 4 de Native Instruments, 
mais elle fonctionne également avec la plupart des logiciels audio professionnels.

Dans ce manuel, vous découvrirez les caractéristiques du GUITAR RIG MOBILE I/O et com-
ment en tirer le meilleur parti. Veuillez lire ce manuel attentivement afin de vous familiariser 
avec ce produit.
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2	 Avant de commencer – Remarques importantes
Commençons par le commencement ; avant d’utiliser le GUITAR RIG MOBILE, nous vous 
conseillons de lire ce chapitre attentivement.

2.1	 Numéros de série et plaque signalétique

GUITAR RIG MOBILE est livré avec deux numéros de série. Le numéro de série de l’interface 
GUITAR RIG MOBILE I/O se trouve sur la face inférieure de l’appareil et le numéro de série 
de la version de GUITAR RIG 4 incluse se trouve sur la pochette du CD d’installation.

La plaque signalétique est située sur la face inférieure de l’appareil. Elle comporte le nom de 
modèle du produit ainsi que des informations techniques. 

2.2	 Utilisation du boîtier en toute sécurité

Veuillez lire attentivement les instructions qui suivent pour prévenir tout risque pour votre 
santé et éviter d’endommager le produit.

2.2.1	 Avertissement
Pour prévenir toute atteinte à votre audition, veuillez systématiquement suivre ces importants 
conseils de sécurité :

•• Utilisé avec un amplificateur, un casque ou des enceintes actives, ce produit peut générer 
des sons à des volumes susceptibles d’entraîner des lésions auditives.

•• Par précaution, réglez tous les volumes au minimum avant d’utiliser le GUITAR RIG MOBILE 
I/O. Augmentez progressivement les contrôles de volume alors que la musique est en cours 
de lecture pour ajuster le niveau d’écoute désiré.
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•• Ne l’utilisez pas à un niveau élevé pendant des périodes trop longues. Si vous éprouvez des 
problèmes d’audition ou des sifflements dans les oreilles, consultez immédiatement un 
médecin spécialiste de l’audition.

2.2.2	 Recommandations
Pour vous assurer que le GUITAR RIG MOBILE I/O ou tout autre matériel connecté à celui-ci 
ne soit pas endommagé pendant son utilisation ou son entretien, il est important que vous 
respectiez ces instructions : 

•• N’ouvrez pas l’appareil, ne tentez pas de le démonter ni de modifier en quoi que ce soit ses 
composants internes. L’appareil ne contient pas d’éléments réparables par l’utilisateur. S’il 
semble mal fonctionner, arrêtez immédiatement de l’utiliser et faites-le vérifier par une per-
sonne qualifiée.

•• N’exposez pas l’appareil à la pluie et ne l’utilisez pas près de l’eau ni dans une atmosphère 
trop humide.

•• Empêchez tout liquide ou toute autre matière de pénétrer dans l’appareil.

•• N’utilisez et ne stockez jamais l’appareil dans des endroits à température élevée (p. ex. à la 
lumière du soleil dans un véhicule fermé ou près d’un radiateur) ou sujets à de fortes vibra-
tions. 

•• Ne placez pas le GUITAR RIG MOBILE I/O en position instable dans laquelle il pourrait 
tomber accidentellement. Avant de déplacer l’unité, débranchez tous les câbles qui lui sont 
connectés.

•• Avant d’allumer ou d’éteindre un appareil quelconque, ramenez les niveaux de volume à 
leurs minimums. 

•• N’exercez pas de pression démesurée sur les potentiomètres ni sur les connecteurs.

•• Lorsque vous nettoyez le GUITAR RIG MOBILE I/O, utilisez un tissu doux et sec. N’utilisez 
jamais de diluant, solvant, liquide de nettoyage ni lingette de nettoyage imprégnée de pro-
duits chimiques.
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2.2.3	 Instructions pour le traitement des déchets
Si le produit venait à être définitivement endommagé, ou si vous désiriez vous en débarrasser, 
veuillez observer la réglementation en vigueur dans votre pays concernant le traitement des 
déchets électroniques.

2.3	 Avis de non-responsabilité

Native Instruments GmbH ne peut être tenue responsable des dégâts ou des pertes de don-
nées occasionnés par une mauvaise utilisation ou une modification du GUITAR RIG MOBILE 
I/O.

Les informations contenues dans ce manuel sont considérées comme correctes à la date de 
sortie. Cependant, Native Instruments se réserve le droit de modifier les spécifications à tout 
moment et sans préavis ni obligation de mettre à jour les appareils existants.
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3	 Parties de l’interface audio GUITAR RIG  
MOBILE I/O

1	 L’entrée (Jack 6,35 mm stéréo TRS) accepte les signaux de niveau instrument. Elle vous 
permet de connecter une grande variété de sources sonores, dont notamment votre guitare 
ou votre basse électrique. Pour une entrée stéréo, un séparateur (câble d’insert / câble 
en Y, non inclus) est nécessaire.

2	 Le contrôle du niveau d’entrée vous permet d’ajuster l’amplification du signal audio en-
trant.

3	 La diode d’activité d’entrée indique le niveau du signal audio en entrée. Une lumière verte 
indique la présence d’un signal, tandis qu’une lumière rouge indique la saturation, ce qui 
signifie que le niveau d’entrée est trop élevé.

4	 La sortie (Jack 6,35 mm stéréo TRS) transmet le signal de sortie reçu depuis l’applica-
tion sur votre ordinateur, par exemple GUITAR RIG 4 ou votre séquenceur. En fonction 
de votre système d’amplification, un séparateur (câble d’insert / câble en Y, non inclus) 
peut être nécessaire pour la transmission stéréo.
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5	 Le contrôle du niveau de sortie. Tournez le volume au minimum avant de connecter quoi 
que ce soit à la sortie, en particulier un casque.

6	 La diode d’activité USB indique si le GUITAR RIG MOBILE I/O est connecté ou non à un 
port USB.

7	 Le port USB vous permet de connecter l’unité à votre ordinateur. Votre ordinateur doit 
satisfaire aux spécifications USB 2.0 afin de pouvoir faire fonctionner le GUITAR RIG 
MOBILE I/O.
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4	 Installation sous Windows XP / Windows Vista
Ce chapitre décrit l’installation de base de GUITAR RIG MOBILE sous Windows XP et Vista, 
en se concentrant sur l’interface GUITAR RIG MOBILE I/O. Pour des informations détaillées 
sur le logiciel GUITAR RIG 4, veuillez consulter son manuel de référence. Vous trouverez ce-
lui-ci sur le CD d’installation ainsi que dans le menu Help > Open Manual > Français dans 
GUITAR RIG 4.

4.1	 Installation du logiciel

Assurez-vous d’être connecté(e) à votre ordinateur avec des droits d’administration. Ne connec-
tez pas encore le GUITAR RIG MOBILE I/O !

1.	 Naviguez dans le contenu du CD et localisez le fichier d’installation. Il est intitulé « Guitar 
Rig 4 Setup ». Si vous utilisez une version téléchargée de GUITAR RIG 4, il vous faut 
d’abord décompresser les fichiers d’installation.

2.	 Double-cliquez sur le fichier « Guitar Rig 4 Setup » pour lancer la procédure d’installation.
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3.	 Suivez les instructions s’affichant à l’écran – elles vous guideront au cours de la procédure 
d’installation du logiciel.

4.	 L’installeur vous demandera de spécifier le chemin d’accès au dossier de plug-ins de 
votre DAW (Digital Audio Workstation, par exemple votre logiciel de séquençage). Si vous 
comptez utiliser GUITAR RIG 4 uniquement en mode autonome, ou si vous ne savez pas 
ce qu’est un plug-in, utilisez le réglage proposé par défaut.

5.	 L’installeur vous demandera si vous souhaitez installer les pilotes pour les interfaces audio 
GUITAR RIG. Sélectionnez « Mobile I/O » puis cliquez sur « Continue ».

6.	 Au cours de l’installation du pilote, quelques message de sécurité Windows apparaissent, 
du genre « Le pilote n’a pas été validé lors du test permettant d’obtenir le logo Windows » 
ou bien « Windows ne peut vérifier l’identité du fabricant de ce pilote logiciel ». Ne 
vous faites pas de souci, c’est tout à fait normal. Cliquez simplement sur « Continuer » 
(Windows XP) ou sur « Installer » (Windows Vista) pour poursuivre l’installation.
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7.	 Une fois l’installation achevée, redémarrez votre ordinateur.

Les applications suivantes ont été placées sur votre disque dur :

•• GUITAR RIG 4 – l’application autonome complète.

•• Plug-ins GUITAR RIG 4 – utilisez GUITAR RIG 4 comme plug-in dans le séquenceur de votre 
choix. Sur les ordinateurs Windows, GUITAR RIG 4 peut fonctionner en plug-in aux formats 
VST et RTAS®.

•• Service Center de Native Instruments – cette application gère l’activation des produits et 
leurs mises à jour. Veuillez consultez le Guide d’Installation pour plus de détails.

•• Les pilotes pour l’interface audio GUITAR RIG MOBILE I/O.

% 
Si vous n’avez encore jamais possédé de produit NATIVE INSTRUMENTS, il vous faudra vous 
enregistrer en suivant les instructions à l’écran. Vous trouverez plus d’informations concernant 

la création d’un Compte Utilisateur NI et l’activation de GUITAR RIG 4 dans le Guide d’Installation et 
le Manuel du Service Center, situés dans le dossier d’installation du Service Center. 
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Si vous souhaitez installer uniquement les pilotes de l’interface, un fichier installeur distinct 
est disponible sur le CD d’installation. Vous pouvez également en télécharger la version la 
plus récente depuis la section d’assistance du site web de Native Instruments.

4.2	 Installation du matériel

Utilisez le câble USB fourni pour brancher le GUITAR RIG MOBILE I/O à un port USB 2.0 
de votre ordinateur.

GUITAR RIG MOBILE I/O est alimenté par le bus USB. Le fonctionnement n’est garanti qu’en 
périphérique unique, sur un contrôleur USB 2.0 ou sur un hub USB 2.0 auto-alimenté. Sur les 
systèmes Windows XP, le Service Pack 2 est requis pour le bon fonctionnement du GUITAR 
RIG MOBILE I/O – vous en saurez plus sur la version de votre système en ouvrant la fenêtre 
Propriétés Système.
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Une fois le pilote correctement installé, le GUITAR RIG MOBILE I/O est reconnu automati-
quement. Si ce n’est pas le cas, relancez l’installation du logiciel comme expliqué ci-dessus.

Plusieurs modules de pilotes sont alors assignés au GUITAR RIG MOBILE I/O, chacun d’eux 
entraînant l’éclosion d’une fenêtre pop-up qui vous demande comment vous souhaitez installer 
le nouveau périphérique. 

1.	 Choisissez de ne pas vous connecter au site web Windows Update.

2.	 Choisissez « Installer le logiciel automatiquement » (Windows XP) ou « Localiser et ins-
taller les pilotes logiciels » (Windows Vista).
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3.	 Suivez les instructions à l’écran pour terminer cette procédure.

4.	 Au cours de l’installation du pilote, quelques message de sécurité Windows apparaissent, 
du genre « Le pilote n’a pas été validé lors du test permettant d’obtenir le logo Windows » 
ou bien « Windows ne peut vérifier l’identité du fabricant de ce pilote logiciel ». Cliquez 
simplement sur « Continuer » (Windows XP) ou sur « Installer » (Windows Vista) pour 
poursuivre l’installation.

Sur un ordinateur Windows, le pilote est associé à un port USB particulier. Si vous branchez 
le câble USB sur un autre port que celui sur lequel le pilote a été installé, le processus d’assi-
gnation du pilote est relancé – si c’est le cas, suivez à nouveau les étapes décrites plus haut.

Si à un moment ou à un autre, l’ordinateur ne semble pas reconnaître le GUITAR RIG MOBILE 
I/O, déconnectez le câble USB, attendez quelques secondes, puis reconnectez-le. Si le pro-
blème persiste, redémarrez votre ordinateur avec l’interface connectée.
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4.3	 Configuration

Ce chapitre vous explique comment utiliser l’interface audio GUITAR RIG MOBILE I/O sous 
Windows XP / Windows Vista, en particulier avec le logiciel GUITAR RIG 4 inclus. Nous sup-
posons ici que vous avez déjà activé GUITAR RIG 4 via le Service Center – veuillez consulter 
le Guide d’Installation pour de l’aide à ce sujet.

4.3.1	 Configuration de GUITAR RIG 4
Nous allons maintenant configurer GUITAR RIG 4 pour utiliser l’interface GUITAR RIG MOBILE 
I/O. Veuillez tout d’abord lancer le logiciel.

1.	 Lorsque le logiciel est lancé pour la première fois, la fenêtre Audio Setup s’ouvre auto-
matiquement ; c’est là que vous devez effectuer les réglages suivants. Pour accéder à 
ces réglages ultérieurement, sélectionnez File > Audio and MIDI Settings dans la barre 
de menus de l’application.

	

2.	 Dans l’onglet « Audio », choisissez ASIO dans le menu « Driver ».
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3.	 Sélectionnez l’entrée GUITAR RIG MOBILE I/O dans le menu « Device ».

Si le GUITAR RIG MOBILE I/O n’apparaît pas dans la liste, quelque chose ne va pas. Relancez 
l’installation telle que décrite à la section 4.1.

Vous pouvez accéder au Control Panel (panneau de contrôle) du pilote en cliquant sur « ASIO 
Config ». Dans le Control Panel du pilote, deux champs situés en bas de la fenêtre indiquent 
si le GUITAR RIG MOBILE I/O est prêt et s’il est connecté.

	

L’interface audio peut être configurée via les paramètres suivants :

•• Presets : plusieurs presets sont proposés pour les utilisations classiques, de la latence mi-
nimale (pour les systèmes rapides avec de puissants processeurs) à des latences plus 
élevées, mieux adaptées aux configurations moins rapides. Si vous êtes habitué(e) au réglage 
des pilotes audio et souhaitez créer votre propre configuration, sélectionnez User Defined 
Settings.
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•• USB Buffersize et Audio Buffersize (tailles des tampons USB et Audio) : ces paramètres 
sont grisés sauf si User Defined Settings est sélectionné dans le menu Presets. Ces deux 
paramètres définissent ensemble la latence du système, c’est-à-dire le temps qui s’écoule 
entre la réception d’un signal audio par le GUITAR RIG MOBILE I/O et le moment où vous 
entendez ce son dans vos enceintes ou vos écouteurs. La taille du tampon audio (Audio 
Buffersize) doit toujours être au moins deux fois plus grande que celle du tampon USB (USB 
Buffersize). Veuillez noter que le paramètre USB Buffersize affecte directement l’utilisation 
de CPU par le système audio. L’utilisation du CPU varie d’un ordinateur à un autre ; n’hési-
tez pas à tester différents réglages.

•• Sample Rate (taux d’échantillonnage) : choisissez un taux d’échantillonnage compatible avec 
votre logiciel audio et adapté à la puissance de votre ordinateur. Par défaut, le taux d’échan-
tillonnage est de 44100 Hz (qualité CD). Les taux d’échantillonnage plus élevés peuvent 
améliorer la qualité audio, mais ils entraînent également plus de calculs pour le processeur.

Nous vous recommandons de sélectionner d’abord l’un des presets de latence proposés et 
de poursuivre avec les autres étapes de la configuration. Une fois le tout achevé, revenez 
à la fenêtre Audio and MIDI Settings pour trouver le meilleur réglage de latence pour votre 
système. Si des ruptures audio surviennent avec le réglage minimal latency, vous pouvez es-
sayer l’un des réglages low latency ou standard latency. Les valeurs de latence plus élevées 
réduisent le risque de ruptures dans l’audio.

4.3.2	 Utilisation du GUITAR RIG MOBILE I/O comme interface audio par défaut
Si vous souhaitez utiliser le GUITAR RIG MOBILE I/O pour la lecture dans toutes vos appli-
cations audio sur votre ordinateur (et non uniquement pour vos logiciels de musique), vous 
devez le définir comme interface audio par défaut.

Sous Windows XP, faites comme suit :

1.	 Ouvrez Démarrer > Panneau de Configuration > Sons et Périphériques Audio.

2.	 Sélectionnez l’onglet « Audio ».

3.	 Dans les sections « Lecture Audio » et « Enregistrement Audio », cliquez sur le menu 
Unité par Défaut et choisissez GUITAR RIG MOBILE I/O.
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4.	 Cliquez sur OK pour fermer la fenêtre « Sons et Périphériques Audio ».

	

Sous Windows Vista, faites comme suit :

1.	 Ouvrez Démarrer > Panneau de configuration > Matériel et audio > Son.

2.	 Sélectionnez l’onglet « Lecture ».

3.	 Dans la liste des périphériques, sélectionnez GUITAR RIG MOBILE I/O puis cliquez sur 
« Définir par défaut ».

4.	 Sélectionnez l’onglet « Enregistrement ».
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5.	 Dans la liste des périphériques, sélectionnez GUITAR RIG MOBILE I/O puis cliquez sur 
« Définir par défaut ».

6.	 Cliquez sur OK pour fermer la boîte de dialogue.

4.4	 Connexions audio et niveaux

Dans les sections qui suivent, vous apprendrez à connecter votre guitare et votre système 
d’amplification au GUITAR RIG MOBILE I/O ainsi qu’à régler correctement les niveaux d’am-
plification, du côté matériel comme du côté logiciel.

Veuillez lancer tout d’abord le logiciel GUITAR RIG 4.

4.4.1	 Connecter l’entrée et ajuster son niveau
1	 Diminuez le volume sur votre système d’amplification afin d’éviter tout dommage auditif.

2	 Branchez le câble connecté à votre guitare ou basse dans l’entrée de l’interface.

Ayez à l’esprit que, pour un instrument générant un signal stéréo, vous aurez besoin d’un 
séparateur (câble d’insert / câble en Y, non inclus) pour router les deux canaux dans l’entrée 
stéréo.
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Afin d’obtenir la meilleure qualité sonore, il convient d’avoir un signal suffisamment puissant ; 
pour cela, il vous faut ajuster le niveau d’entrée du GUITAR RIG MOBILE I/O.

L’Input Level LED vous aide à identifier visuellement le niveau du signal entrant :

État de la diode Signification

Diode éteinte Aucun signal en entrée

Diode allumée verte Signal entrant

Diode allumée rouge Signal entrant trop fort

Avant d’ajuster le gain d’entrée, montez le volume sur votre guitare. Grattez quelques cordes avec 
le volume que vous comptez utiliser lors de l’enregistrement, et contrôlez l’Input Level LED :

1.	 Montez le niveau d’entrée jusqu’à ce que la diode commence tout juste à passer au rouge 
lorsque vous jouez.

2.	 Maintenant, tournez très légèrement le curseur en arrière, jusqu’à ce que la diode ne 
s’allume plus en rouge, même quand vous jouez vraiment fort sur votre instrument.

La sensibilité d’entrée est maintenant réglée à son niveau optimal, permettant ainsi au GUITAR 
RIG MOBILE I/O de fournir la plus grande dynamique possible sans saturer.

4.4.2	 Le niveau d’entrée de GUITAR RIG 4
Nous supposons ici que votre guitare est connectée au GUITAR RIG MOBILE I/O et que son 
niveau d’entrée est correctement réglé (cf. section 4.4.1). Vous devez maintenant vous assurer 
que le signal d’entrée est traité à un niveau correct par le logiciel.
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Jetez un œil à l’en-tête de la fenêtre de GUITAR RIG 4 : il contient le module d’entrée avec 
le sélecteur de canal, une porte de bruit basique, le module de sortie avec un limiteur et des 
informations sur la consommation de ressources processeur.

% 
Pour une description et une explication détaillées du circuit de Réduction de Bruit, veuillez 
consulter le Manuel de Référence de GUITAR RIG 4 inclus sur votre CD-ROM.

Notez que l’Input Meter affiche une certaine amplitude lorsque vous jouez. Il dispose égale-
ment d’un réglage de volume intégré qui contrôle le niveau d’entrée du logiciel. Ajustez-le de 
manière à obtenir le niveau le plus élevé possible sans que votre signal ne sature. Ceci est 
indiqué par le Level Meter qui s’approche du rouge sans toutefois l’atteindre.

Nous allons maintenant configurer le composant Input afin qu’il route le signal de votre guitare 
vers les deux canaux. La plupart des guitares étant mono, GUITAR RIG 4 reçoit un signal 
mono transmis sur le canal gauche. Par défaut, GUITAR RIG 4 est réglé pour traiter les deux 
canaux d’entrée (L et R sont activés), et le canal droit reste logiquement muet. Pour modifier 
ceci, cliquez sur le bouton R à gauche de l’Input Meter pour désactiver le canal d’entrée droit. 
Ceci routera le signal mono sur les deux canaux d’entrée.

4.4.3	 Connecter la sortie
GUITAR RIG MOBILE I/O fournit une sortie stéréo qui fonctionne à la fois pour les systèmes 
d’amplification et pour un casque. Gardez à l’esprit que l’utilisation d’un câble mono (tel qu’un 
câble de guitare) ne transmettra qu’un canal seulement – vous aurez peut-être besoin d’un 
séparateur (câble d’insert / câble en Y) pour router les deux canaux vers les entrées de votre 
système d’amplification.

Utilisez un câble stéréo pour connecter la sortie jack du GUITAR RIG MOBILE I/O aux appa-
reils disposant d’une entrée stéréo.
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Avant d’allumer votre système d’amplification ou de brancher votre casque, vérifiez que le 
niveau de sortie de votre interface audio est descendu au minimum.

•• Si vous utilisez un système d’amplification, connectez le câble de sortie à son entrée et allumez-le.

•• Si vous utilisez un casque, connectez-le à la sortie et placez-le sur votre tête.

•• Rendez-vous dans le Preset Browser et sélectionnez un preset en cliquant dessus. 
Commencez à jouer et augmentez avec précaution le volume de sortie du GUITAR RIG 
MOBILE I/O jusqu’au niveau souhaité. Tout est prêt, vous pouvez envoyer la sauce !

% 
Si votre instrument n’utilise qu’un seul canal, baissez complètement le curseur Gain de 
l’autre canal.
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5	 Installation sous Mac OS X
Ce chapitre décrit l’installation de base de GUITAR RIG MOBILE sous Mac OS X, en se 
concentrant sur l’interface GUITAR RIG MOBILE I/O. Pour des informations détaillées sur le 
logiciel GUITAR RIG 4, veuillez consulter son manuel de référence. Vous trouverez celui-ci 
sur le CD d’installation ainsi que dans le menu Help > Open Manual > Français dans GUITAR 
RIG 4.

5.1	 Installation du logiciel

Assurez-vous d’être connecté(e) à votre ordinateur avec des droits d’administration. Ne connec-
tez pas encore le GUITAR RIG MOBILE I/O !

1.	 Naviguez dans le contenu du disque et localisez le fichier « Guitar Rig 4 Installer ». Si 
vous utilisez une version téléchargée de GUITAR RIG 4, vous devez d’abord décompresser 
le fichier d’installation.

2.	 Double-cliquez sur le fichier de l’installeur pour démarrer la procédure d’installation.
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3.	 Suivez les instructions s’affichant à l’écran – elles vous guideront au cours de la procédure 
d’installation du logiciel.

4.	 L’installeur vous demandera si vous souhaitez installer les pilotes pour les interfaces audio 
GUITAR RIG. Sélectionnez « Mobile I/O » puis cliquez sur « Continue ».

5.	 Une fois l’installation achevée, redémarrez votre ordinateur.

Les applications suivantes sont placées sur votre disque dur :

•• GUITAR RIG 4 – l’application autonome complète.

•• Plug-in GUITAR RIG 4 – utilisez GUITAR RIG 4 comme plug-in dans le séquenceur de votre 
choix.

•• Service Center de Native Instruments – cette application gère l’activation des produits et 
leurs mises à jour. Veuillez consultez le Guide d’Installation pour plus de détails.

•• Les pilotes pour l’interface audio GUITAR RIG MOBILE I/O.

% 
Si vous n’avez encore jamais possédé de produit NATIVE INSTRUMENTS, il vous faudra 
vous enregistrer en suivant les instructions à l’écran. Vous trouverez plus d’informations 

concernant la création d’un Compte Utilisateur NI et l’activation de GUITAR RIG 4 dans le 
Guide d’Installation et le Manuel du Service Center, situés dans le dossier d’installation du 
Service Center.

Si vous souhaitez installer uniquement les pilotes de l’interface, un fichier installeur 
distinct est disponible sur le CD d’installation. Vous pouvez également en télécharger la version 
la plus récente depuis la section d’assistance du site web de Native Instruments.
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5.2	 Installation du matériel

Utilisez le câble USB fourni pour brancher le GUITAR RIG MOBILE I/O à un port USB 2.0 
de votre ordinateur.

GUITAR RIG MOBILE I/O est alimenté par le bus USB. Le fonctionnement n’est garanti qu’en 
périphérique unique, sur un contrôleur USB 2.0 ou sur un hub USB 2.0 auto-alimenté.

Une fois le pilote correctement installé, le GUITAR RIG MOBILE I/O doit être reconnu automa-
tiquement. Si à un moment ou à un autre, l’ordinateur ne semble pas reconnaître le GUITAR 
RIG MOBILE I/O, déconnectez le câble USB, attendez quelques secondes, puis reconnectez-
le. Si le problème persiste, redémarrez votre ordinateur avec l’interface connectée.
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5.3	 Configuration

Ce chapitre vous explique comment utiliser l’interface audio GUITAR RIG MOBILE I/O sous 
Mac OS X, en particulier avec le logiciel inclus GUITAR RIG 4. Nous supposons ici que vous 
avez déjà activé GUITAR RIG 4 via le Service Center – veuillez consulter le Guide d’Installation 
pour de l’aide à ce sujet.

5.3.1	 Configuration de GUITAR RIG 4
Nous allons maintenant configurer GUITAR RIG 4 pour utiliser l’interface GUITAR RIG MOBILE 
I/O. Veuillez tout d’abord lancer le logiciel.

1.	 Lancez GUITAR RIG 4. Lorsque le logiciel est lancé pour la première fois, la fenêtre 
Audio Setup s’ouvre automatiquement ; c’est là que vous devez effectuer les réglages 
suivants. Si vous voulez accéder à ces réglages plus tard, sélectionnez GUITAR RIG 4 > 
Preferences dans le menu du programme.

	

2.	 Sur l’onglet « Audio », choisissez CoreAudio dans le menu « Driver ».



GUITAR RIG MOBILE – 30

3.	 Sélectionnez l’entrée GUITAR RIG MOBILE I/O dans le menu « Device ».

Si le GUITAR RIG MOBILE I/O n’apparaît pas dans la liste alors qu’il est connecté, quelque 
chose ne va pas. Relancez l’installation telle que décrite à la section 5.1.

L’interface audio peut être configurée via les paramètres suivants :

•• Sample Rate (taux d’échantillonnage) : choisissez un taux d’échantillonnage compatible avec 
votre logiciel audio et adapté à la puissance de votre ordinateur. Par défaut, le taux d’échan-
tillonnage est de 44100 Hz (qualité CD). Les taux d’échantillonnage plus élevés peuvent 
améliorer la qualité audio, mais ils entraînent également plus de calculs pour le processeur.

•• Latency : utilisez la tirette Latency pour régler la taille du tampon de l’interface audio, me-
surée en échantillons. Ceci a deux effets : plus le tampon audio est grand, plus la probabi-
lité de ruptures audio est faible. D’un autre côté, la taille du tampon affecte directement la 
latence globale (le délai) de votre système. Plus la latence est élevée, plus le temps entre 
l’instant où vous jouez une note et celui où vous l’entendez est long.

Nous vous recommandons de commencer avec la taille de tampon par défaut, puis de conti-
nuer avec les autres étapes de la configuration. Une fois le tout achevé, chargez un preset 
de base et revenez à la fenêtre Audio and MIDI Settings pour trouver le meilleur réglage de 
latence pour votre système. Ceci s’effectue en diminuant progressivement la taille du tam-
pon : glissez la tirette de latence vers la gauche tout en jouant quelque chose. Lorsque vous 
commencez à entendre des craquements ou des ruptures, glissez lentement la tirette vers la 
droite jusqu’à ce que ces artefacts aient entièrement disparu.

5.3.2	 Utilisation du GUITAR RIG MOBILE I/O comme interface audio par défaut
Si vous souhaitez utiliser le GUITAR RIG MOBILE I/O pour la lecture dans toutes vos appli-
cations audio sur votre ordinateur (et non uniquement pour vos logiciels de musique), vous 
devez le définir comme interface audio par défaut. Sous Mac OS X, faites comme suit :

1.	 Dans le Menu Pomme, choisissez Préférences Système.
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2.	 Dans le panneau qui s’ouvre, sélectionnez « Son ».

	

3.	 Cliquez alors sur l’onglet Effets Sonores et choisissez GUITAR RIG MOBILE I/O dans le 
menu « Émettre alertes et effets sonores via ».

4.	 Cliquez sur l’onglet Sortie et sélectionnez GUITAR RIG MOBILE I/O dans la liste 
« Choisissez un appareil pour la sortie son ».

5.	 Cliquez sur l’onglet Entrée et sélectionnez GUITAR RIG MOBILE I/O dans la liste 
« Choisissez un appareil pour l’entrée son ».

5.4	 Connexions audio et niveaux

Dans les sections qui suivent, vous apprendrez à connecter votre guitare et votre système 
d’amplification au GUITAR RIG MOBILE I/O ainsi qu’à régler correctement les niveaux d’am-
plification, du côté matériel comme du côté logiciel.

Veuillez lancer tout d’abord le logiciel GUITAR RIG 4.
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5.4.1	 Connecter l’entrée et ajuster son niveau
1.	 Diminuez le volume sur votre système d’amplification afin d’éviter tout dommage auditif.

2.	 Branchez le câble connecté à votre guitare ou basse dans l’entrée de l’interface.

3.	 Ayez à l’esprit que, pour un instrument générant un signal stéréo, vous aurez besoin d’un 
séparateur (câble d’insert / câble en Y, non inclus) pour router les deux canaux dans 
l’entrée stéréo.

Afin d’obtenir la meilleure qualité sonore, il convient d’avoir un signal suffisamment puissant ; 
pour cela, il vous faut ajuster le niveau d’entrée du GUITAR RIG MOBILE I/O.

L’Input Level LED vous aide à identifier visuellement le niveau du signal entrant :

État de la diode Signification

Diode éteinte Aucun signal en entrée

Diode allumée verte Signal entrant

Diode allumée rouge Signal entrant trop fort
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Avant d’ajuster le gain d’entrée, montez le volume sur votre guitare. Grattez quelques cordes 
avec le volume que vous comptez utiliser lors de l’enregistrement, et regardez l’Input Level LED :

1.	 Montez le niveau d’entrée jusqu’à ce que la diode commence tout juste à passer au rouge 
lorsque vous jouez.

2.	 Maintenant, tournez très légèrement le curseur en arrière, jusqu’à ce que la diode ne 
s’allume plus en rouge, même quand vous jouez vraiment fort sur votre instrument.

La sensibilité d’entrée est maintenant réglée à son niveau optimal, permettant ainsi au GUITAR 
RIG MOBILE I/O de fournir la plus grande amplitude de dynamique sans saturer.

5.4.2	 Le niveau d’entrée de GUITAR RIG 4
Nous supposons ici que votre guitare est connectée au GUITAR RIG MOBILE I/O et que son 
niveau d’entrée est correctement réglé (cf. section 5.4.1). Nous devons maintenant nous as-
surer que le signal d’entrée est traité à un niveau correct par le logiciel.

Jetez un œil à l’en-tête de la fenêtre de GUITAR RIG 4 : il contient le module d’entrée avec 
le sélecteur de canal, une porte de bruit basique, le module de sortie avec un limiteur et des 
informations sur la consommation de ressources processeur.

% 
Pour une description et une explication détaillées du circuit de Réduction de Bruit, veuillez 
consulter le Manuel de Référence de GUITAR RIG 4 inclus sur votre CD-ROM.

Notez que l’Input Meter affiche une certaine amplitude lorsque vous jouez. Il dispose égale-
ment d’un réglage de volume intégré qui contrôle le niveau d’entrée du logiciel. Ajustez-le de 
manière à obtenir le niveau le plus élevé possible sans que votre signal ne sature. Ceci est 
indiqué par le Level Meter qui s’approche du rouge sans toutefois l’atteindre.

Nous allons maintenant configurer le composant Input afin qu’il route le signal de votre guitare 
vers les deux canaux. La plupart des guitares étant mono, GUITAR RIG 4 reçoit un signal 
mono transmis sur le canal gauche. Par défaut, GUITAR RIG 4 est réglé pour traiter les deux 
canaux d’entrée (L et R sont activés), et le canal droit reste logiquement muet. Pour modifier 
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ceci, cliquez sur le bouton R à gauche de l’Input Meter pour désactiver le canal d’entrée droit. 
Ceci routera le signal mono sur les deux canaux d’entrée.

5.4.3	 Connecter la sortie
GUITAR RIG MOBILE I/O fournit une sortie stéréo qui fonctionne à la fois pour les systèmes 
d’amplification et pour un casque. Gardez à l’esprit que l’utilisation d’un câble mono (tel qu’un 
câble de guitare) ne transmettra qu’un canal seulement – vous aurez peut-être besoin d’un 
séparateur (câble d’insert / câble en Y) pour router les deux canaux vers les entrées de votre 
système d’amplification.

Utilisez un câble stéréo pour connecter la sortie jack du GUITAR RIG MOBILE I/O aux appa-
reils disposant d’une entrée stéréo.

Avant d’allumer votre système d’amplification ou de brancher votre casque, vérifiez que le 
niveau de sortie de votre interface audio est descendu au minimum.

•• Si vous utilisez un système d’amplification, connectez le câble de sortie à son entrée et 
allumez-le.
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•• Si vous utilisez un casque, connectez-le à la sortie et placez-le sur votre tête.

•• Rendez-vous dans le Preset Browser et sélectionnez un preset en cliquant dessus. 
Commencez à jouer et augmentez avec précaution le volume de sortie du GUITAR RIG 
MOBILE I/O jusqu’au niveau souhaité. Tout est prêt, vous pouvez envoyer la sauce !

% 
Si votre instrument n’utilise qu’un seul canal, baissez complètement le curseur Gain de 
l’autre canal.
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6	 Dépannage
Si vous rencontrez un quelconque problème avec votre matériel, nous vous recommandons de 
suivre ces quelques étapes pour trouver la solution avant de contacter l’équipe d’assistance 
technique :

•• Rendez-vous sur la Base de Connaissances (Knowledge Base) en ligne de NI. Le moyen le 
plus simple de la trouver est de sélectionner Help > Visit the Knowledgebase... dans le menu 
de l’application.

•• Rendez-vous sur le User Forum (forum des utilisateurs) sur le site web de NI (http://www.
native-instruments.com/forum/) et effectuez une recherche pour trouver les réponses éven-
tuelles de la communauté d’utilisateurs et utilisatrices de GUITAR RIG.

Lorsque vous prenez contact avec l’équipe d’assistance technique (Technical Support),  
vérifiez que vous avez à portée de main toutes les informations nécessaires concernant votre 
ordinateur. Pour les informations sur la version du pilote et la révision du microprogramme 
(firmware), veuillez regarder dans le Driver Control Panel.

•• Sur les ordinateurs Windows, vous trouverez la version du pilote et du microprogramme en 
sélectionnant le Driver Control Panel dans Démarrer > Programmes > Native Instruments 
> GUITAR RIG MOBILE IO Driver. Ces informations sont affichées lorsque vous cliquez sur 
« About ».

•• Sous Mac OS X, vous pouvez accéder au Driver Control Panel depuis les Préférences 
Système. Les informations sont affichées dans la fenêtre principale.

Pour contacter l’équipe d’assistance, veuillez vous rendre à cette URL : 

http://native-instruments.com/support/

Pendant leur phase de développement, tous les produits Native Instruments sont testés de 
manière extensive dans des situations réelles. Néanmoins, si votre produit doit être renvoyé, 
l’équipe d’Assistance Technique (Technical Support) vous fournira un numéro RA (Return 
Authorization, Autorisation de Retour) pour accélérer le processus de retour. Veuillez contacter 

http://native-instruments.com/forum/
http://native-instruments.com/forum/
http://native-instruments.com/support/
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notre équipe d’Assistance Technique avant de renvoyer un quelconque produit. Les paquets 
renvoyés sans ce numéro RA ne pourront être correctement identifiés, et risquent ainsi de 
ne pas être pris en charge efficacement.

6.1	 Problèmes audio

Cette section vous propose de l’aide pour les problèmes audio les plus courants.

6.1.1	 Pas de son ou volume faible
Si votre sortie audio est muette ou faible, différentes causes sont possibles :

•• Câbles débranchés ou défectueux. Veuillez vérifier tous les branchements et tous les câbles.

•• Mauvaise carte son ou entrée audio sélectionnée. Veuillez sélectionner l’entrée Audio and 
MIDI Settings dans le menu de GUITAR RIG 4 et vérifier si le pilote GUITAR RIG MOBILE 
I/O est bien sélectionné dans la fenêtre qui s’ouvre. 

•• Mauvais canal choisi dans le module Input de GUITAR RIG 4. Passez à l’autre canal en 
choisissant « L » dans le composant Input.

•• Le gain d’entrée du GUITAR RIG MOBILE I/O est réglé trop bas. Augmentez le niveau d’en-
trée.

•• Le potentiomètre de volume de votre instrument est réglé à un niveau trop faible. Augmentez-
le progressivement.

6.1.2	 Signal distordu
Si le signal audio semble être distordu alors qu’aucune distorsion n’est ajoutée par le logiciel 
GUITAR RIG 4, il est probable que le gain d’entrée du GUITAR RIG MOBILE I/O soit trop 
élevé. Réduisez l’Input Level sur l’interface pour empêcher la saturation du préamplificateur. 
Si votre instrument produit un signal de niveau si fort que le préampli sature toujours, réduisez 
le volume directement sur votre guitare. Généralement, ceci ne se produit que si l’instrument 
est équipé d’une électronique active et de micros (pickups) spéciaux à sortie haute puissance.
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6.1.3	 Bruit
Un bourdonnement audible peut avoir plusieurs origines, dont certaines sont détaillées  
ci-dessous :

•• Les micros à simple bobinage sont sensibles aux interférences électriques. Les micros à 
double bobinage (humbuckers) produisent beaucoup moins de bruit, d’où leur nom (de 
« hum » = « bourdonnement » et « to buck » = « réduire »...).

•• Votre guitare est placée trop près d’un équipement électrique. Pour réduire ce type de 
bourdonnement, éloignez la guitare de l’équipement électrique en question.

•• Le potentiomètre de volume de la guitare est à un niveau trop faible. Tournez-le pour aug-
menter le volume. Si votre guitare possède plusieurs boutons de volume, assurez-vous de 
les avoir tous vérifiés.

•• Vous utilisez un câble pour guitare défectueux ou non blindé. Il est aussi possible que le 
blindage de votre guitare elle-même soit inadéquat. Commencez par essayer de remplacer 
votre câble de guitare par un modèle blindé. Si cela n’arrange rien, il vous faudra peut-être 
faire réviser l’électronique et le blindage de votre guitare par un spécialiste.

Si vous entendez des sifflements, le niveau d’entrée du GUITAR RIG MOBILE I/O est peut-
être trop faible. Montez le volume de votre instrument ou augmentez le niveau d’entrée sur le 
GUITAR RIG MOBILE I/O. Pour plus d’informations concernant le réglage du niveau d’entrée, 
veuillez vous reporter à la section 4.4 (Windows XP / Windows Vista) ou à la section 5.4 (Mac 
OS X) de ce manuel.

6.1.4	 Boucles de masse
Les boucles de masse (généralement perçues comme un bourdonnement ou un grésillement) 
constituent un problème classique lorsque de multiples appareils électriques sont connectés 
au même circuit d’alimentation électrique. Les étapes suivantes devraient vous aider à élimi-
ner la boucle de masse :

•• Débranchez tous les appareils que vous n’utilisez pas actuellement, notamment les périphé-
riques externes de votre ordinateur (disques durs externes, graveurs de CD, etc.).
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•• Branchez un boîtier de direct (DI Box) derrière les sorties du GUITAR RIG MOBILE I/O. La 
plupart de ces boîtiers disposent d’un interrupteur « ground lift » qui vous permet de briser 
la boucle de masse et d’éliminer le bruit.

6.2	 Problèmes liés au matériel

Vérifiez régulièrement sur le site web de Native Instruments et via le Service Center de NI la 
présence éventuelle de mises à jour pour le pilote du GUITAR RIG MOBILE I/O et d’autres 
informations utiles.

6.2.1	 Problèmes avec le pilote
Assurez-vous que le boîtier du GUITAR RIG MOBILE I/O est connecté à l’ordinateur, et ouvrez 
le Driver Control Panel. Lisez l’introduction de ce chapitre pour savoir comment trouver le 
Control Panel.

Si le Driver Control Panel est absent, le pilote n’est probablement pas installé du tout. Dans 
ce cas, veuillez réinstaller le pilote comme décrit plus haut.

Si tous les menus déroulants du Control Panel sont grisés, le GUITAR RIG MOBILE I/O n’est 
pas reconnu par le pilote. Il doit y avoir quelque chose d’anormal dans la connexion USB ; 
lisez les sections suivantes pour plus de détails.

6.2.2	 Problèmes avec l’USB
GUITAR RIG MOBILE I/O est une interface USB 2.0 et ne fonctionnera pas sur un port USB 
1.0/1.1. Connectez-la toujours directement à un port USB 2.0 de votre ordinateur. Le port doit 
satisfaire aux spécifications USB 2.0, notamment celles relatives à l’alimentation disponible 
(500 mA). Sur certains ordinateurs, les ports USB 2.0 ne satisfont pas aux spécifications 
officielles de la norme USB 2.0. Si vous êtes dans ce cas, vous verrez peut-être apparaître 
un message vous indiquant que l’alimentation est insuffisante pour faire fonctionner votre 
appareil. Le GUITAR RIG MOBILE I/O peut alors produire des craquements, voire ne pas 
fonctionner du tout.
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•• Si votre ordinateur ne peut pas fournir la puissance électrique nécessaire via USB, essayez 
de brancher le GUITAR RIG MOBILE I/O sur un hub USB 2.0 avec une alimentation externe. 
Évitez de connecter d’autres appareils au hub, car tout périphérique alimenté par le hub 
diminuerait la puissance électrique disponible.

•• En cas d’échec, il est toujours utile de vérifier si le GUITAR RIG MOBILE I/O fonctionne 
lorsque vous déconnectez tous les appareils USB de votre ordinateur, à l’exception de votre 
clavier et de votre souris.

•• Si vous rencontrez des problèmes de ruptures dans l’audio ou d’autres problèmes en relation 
avec la connexion USB, branchez le GUITAR RIG MOBILE I/O sur un autre port USB 2.0.

•• Un mauvais câble USB peut être responsable de ruptures dans l’audio et/ou d’autres pro-
blèmes de connexion. Essayez avec un autre câble comportant le symbole officiel USB, 
parfois l’utilisation d’un câble plus court peut résoudre le problème.

•• Si votre GUITAR RIG MOBILE I/O plante ou fonctionne mal sur une machine Windows, la 
première chose à faire est de désactiver la gestion de l’alimentation des contrôleurs USB, 
activée par défaut. Ouvrez le Gestionnaire de Périphériques (Panneau de Configuration > 
Système > Matériel), et effectuez un clic droit sur un hub USB afin d’en ouvrir les propriétés. 
Sur l’onglet « Gestion de l’alimentation », décochez toutes les cases. Recommencez pour 
chaque hub USB et redémarrez l’ordinateur.

6.2.3	 Utiliser GUITAR RIG MOBILE avec un ordinateur portable
Veuillez vérifier que votre ordinateur est capable de gérer le traitement audio en temps réel 
sans rupture. Il existe quelques logiciels gratuits permettant d’analyser votre système, par 
exemple :

www.thesyco.de/deu/latency_check.shtml

Lancez ce logiciel avec le GUITAR RIG MOBILE I/O déconnecté. Au cas où votre ordinateur 
n’est pas capable de gérer correctement un traitement audio en temps réel, l’outil affiche 
des barres de latence rouges et reporte cette information dans la partie basse de la fenêtre.

http://www.thesyco.de/deu/latency_check.shtml
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De manière générale, il n’est pas recommandé d’utiliser un ordinateur portable avec une carte 
graphique à mémoire partagée. Votre projet audio a besoin de toute la mémoire et de toute 
la puissance de calcul disponibles !

Voici quelques moyens d’optimiser les performances audio de votre ordinateur portable :

•• Il est recommandé de ne pas faire fonctionner votre ordinateur portable sur sa batterie, car 
il est probable que la gestion de l’alimentation diminue automatiquement la fréquence d’hor-
loge du processeur pour économiser de la batterie.

•• Déconnectez tous les périphériques inutilisés (imprimante, scanner...). Ceci augmentera la 
puissance processeur disponible pour votre logiciel audio.

•• Les ordinateurs portables sont souvent équipés de périphériques internes qui perturbent le 
traitement audio, comme par exemple une carte réseau ou une carte sans-fil. Il vous faudra 
peut-être désactiver ces périphériques lorsque vous travaillerez avec le GUITAR RIG MOBILE 
I/O.
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7	 Spécifications Techniques
Ce chapitre contient toutes les spécifications techniques concernant l’interface matérielle 
GUITAR RIG MOBILE I/O.

7.1	 Connexions

•• 1 entrée jack pour fiches jack stéréo 6,35 mm (1/4’’)

•• 1 sortie jack pour fiches jack stéréo de 6,35 mm (1/4’’)

•• 1 fiche USB 2.0 de Type B
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7.2	 Spécifications audio

Entrées audio (Analogique/Numérique)

Canaux 2

Sample Rate 44,1, 48, 88,2, 96, 192 kHz

Résolution numérique 16 ou 24 Bits

Convertisseur Cirrus Logic

Entrées instrument

Impédance d’entrée 1 MΩ asymétrique

Niveau Full Scale (gain max) -4,8 dBu

Niveau d’entrée maximal +15,8 dBu asymétrique

Rapport Signal sur Bruit (pondéré) 100 dBu

Taux de distorsion harmonique (THD + N) 0,006 %

Réponse fréquentielle (+/- 1 dBu) 10 – 40000 Hz
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Sorties audio (Numérique/Analogique)

Canaux 2

Sample Rate 44,1, 48, 88,2, 96, 192 kHz

Résolution numérique 16 ou 24 Bits

Convertisseur Cirrus Logic

Sorties ligne

Impédance de sortie 100 Ω asymétrique, 200 Ω symétrique

Niveau maximal de sortie +14,9 dBu

Rapport Signal sur Bruit (pondéré) 100 dBu

Taux de distorsion harmonique (THD + N) 0,006 %

Réponse fréquentielle (+/- 1 dBu) 10 – 40000 Hz
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Sortie casque

Impédance de charge 16 – 600 ohms

Niveau Maximal de Sortie (charge de 100 
ohms)

2,165 V RMS (charge 100 ohms), 4,345 V RMS  
(sans charge)

Rapport Signal sur Bruit (pondéré) 100 dB

Taux de Distortion Harmonique (THD+N) 
 (à 100 ohms)

0,06%

Réponse fréquentielle (+/- 1 dBu) 10 – 40000 Hz

7.3	 Alimentation électrique

Via l’interface USB 2.0, 5 V – 500 mA

L’appareil n’a pas besoin d’alimentation électrique séparée ni de batterie, l’alimentation est 
fournie par le port USB. Cependant, le fonctionnement du MOBILE I/O n’est garanti qu’en 
périphérique unique, sur un contrôleur USB 2.0 ou sur un hub USB 2.0 auto-alimenté.

7.4	 Dimensions et poids

Dimensions : 90 x 58 x 24 mm (3,54 x 2,28 x 0,94 pouces)

Poids : 90 g (0,198 livres)
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7.5	 Données environnementales

Température de fonctionnement : de 0 à 40 °C (humidité inférieure à 85 %)

Température de stockage : de -20 à 50 °C (humidité inférieure à 85 %)

7.6	 Configuration requise

7.6.1	 Spécifications système générales
Windows XP avec Service Pack 2 ou Windows Vista (32/64 bit), Intel® Pentium™ ou AMD® 
Athlon™ XP 1,4 GHz, 1024 Mo RAM, USB 2.0

Mac OS 10.5, Intel® Core™ Duo 1,66 GHz, 1024 Mo RAM, USB 2.0

7.6.2	 Formats de pilotes pris en charge
•• Mac OS : Core Audio™

•• Windows : ASIO® (recommandé), DirectSound™, WASAPI™

7.6.3	 Plateformes prises en charge
•• Mac OS : application autonome, VST®, Audio Units™, RTAS® (Pro Tools 7/8)

•• Windows : application autonome, VST®, RTAS® (Pro Tools 7/8)
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